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READ ME FIRST

Welcome to Take Control of Users & Accounts in Tiger, version 1.0.

This ebook tells you everything you need to know about users and
accounts in Tiger, how to set them up, configure them, and manage
them. This ebook was written by Kirk McElhearn, edited by Tonya
Engst, and published by TidBITS Electronic Publishing.

You can contact TidBITS Electronic Publishing by sending email to
tc-comments@tidbits.com and view the Take Control Web site and
catalog at http://www.takecontrolbooks.com/. You can read About
This Ebook to learn about the author, the publisher, and the Take
Control series. The title page contains copyright and legal info.

The price of this ebook is $5. If you want to share it with a friend,
please do so as you would with a physical book, meaning that if your
friend uses it regularly, your friend should buy a copy. The Help a
Friend button on the cover makes it easy for you to give your friend
a discount coupon.

We may offer free minor updates to this ebook. Click the Check for
Updates button on the cover to access a Web page that informs you
of any available or upcoming updates. On that page, you can also
sign up to be notified about updates via email.

WARNING! If you use Adobe Acrobat Pro 6 or 7 , make sure your Web Capture
preference is set to view Web URLs in a Web browser before checking
for updates. To do so, choose Acrobat > Preferences, switch to the
Web Capture pane, and choose In Web Browser from the Open Web
Links pop-up menu.

Onscreen Reading Tips
We carefully designed the Take Control ebooks to be read onscreen,
and although most of what you need to know is obvious, note the
following for the best possible onscreen reading experience:

• Blue text indicates links. You can click any item in the Table of
Contents to jump to that section. Cross-references are also links,
as are URLs and email addresses.

mailto:tc-comments@tidbits.com
http://www.takecontrolbooks.com/
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• Work with the Bookmarks tab or drawer showing so that you can
always jump to any main topic by clicking its bookmark.

• Find more tips at http://www.takecontrolbooks.com/faq.html
reading1.

Printing Tips
Although our layout is aimed at making online reading an enjoyable
experience, we’ve made sure that printing remains a reasonable
option. Please review these tips before you print:

• Use the Check for Updates button on the cover to make sure you
have the latest version of the ebook and to verify that we don’t plan
to release a new version shortly. If you want to commit this ebook
to paper, it makes sense to print the latest possible version.

• Don’t throw out your PDF after you print! You must click the
Check for Updates button on the cover to get future updates. The
link must be accessed from the cover of your PDF.

• For a tighter layout that uses fewer pages, check your printer op-
tions for a 2-up feature that prints two pages on one piece of paper.
For instance, your Print dialog may have an unlabeled pop-up
menu that offers a Layout option; choose Layout, and then choose
2 from the Pages per Sheet pop-up menu. You may also wish to
choose Single Hairline from the Border menu.

• When printing on a color inkjet printer, to avoid using a lot of
color ink (primarily on the yellow boxes we use for tips and
figures), look for an option to print entirely in black-and-white.

• In the unlikely event that Adobe Acrobat or Adobe Reader can’t
successfully print this PDF, try Preview; several readers have
solved printing problems by using Preview.

Basics
In reading this ebook, you may get stuck if you don’t know certain
basic facts or if you don’t understand Take Control syntax for things
like working with menus or finding items in the Finder. Please note
the following:

• Path syntax: I occasionally use a path to show the location of a
file or folder in your file system. Path text is formatted in bold type.

http://www.takecontrolbooks.com/faq.html#reading1
http://www.takecontrolbooks.com/faq.html#reading1
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For example, Tiger stores most utilities, such as Disk Utility, in the
Utilities folder. The path to Disk Utility is: /Applications/
Utilities/Disk Utility.

The slash at the start of the path tells you to start from the root
level of the disk. You will also encounter paths that begin with ~
(tilde), which is a shortcut for any user’s home directory. For
example, if a person with the user name joe wants to install fonts
that only he can access, he would install them in his ~/Library/
Fonts folder, which is just another way of writing /Users/joe/
Library/Fonts.

• Menus: When I describe choosing a command from a menu in
the menu bar, I use an abbreviated description. For example, the
abbreviated description for the menu command that displays
information about a file is “File > Get Info.”

• Finding preference panes: I sometimes refers to Mac OS X
preferences that you may want to adjust. To change these system-
wide settings, open System Preferences by clicking its icon in the
Dock or choosing System Preferences from the Apple menu. You
access a particular preference pane by way of its icon, or the View
menu. For example, to see “the Accounts preference pane,” you
would launch System Preferences and then click the Accounts icon
or choose View > Accounts.
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INTRODUCTION

Apple has done an excellent job of hiding many of Mac OS X’s Unix
underpinnings, so Unix-related features such as preemptive multi-
tasking make the Mac work better than ever before, without drawing
attention to themselves. But other aspects of that Unix foundation
do affect the way we work in important and noticeable ways; for ex-
ample, Unix brings a full multi-user operating system to OS X, which
means that each person who wishes to use the Mac must use it while
logged into an account.

This ebook goes much further than just telling you how to set up and
configure user accounts. I cover the different types of accounts, how
to limit the capabilities of certain accounts, and what you need to
know about Fast User Switching. I also explain why you should have
at least two accounts even if no one else uses your Mac.

By the end of this ebook you’ll be able to take control of all your Tiger
accounts—whether you have one or dozens—and work more efficient-
ly with Tiger.
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WORKING WITH ACCOUNTS QUICK START

User accounts affect almost everything you do under Mac OS X. You
must have at least one account, and, if you need to create additional
accounts, you can do so easily. Here’s an overview of how you can use
this ebook to work with accounts in Tiger:

Learn about accounts:

• Learn what user accounts are, and why you need them. Read
About User Accounts.

• Discover what has changed with accounts from Panther to Tiger.
See What’s New in Tiger.

• Find out about five types of user accounts in Types of Accounts.

• Learn strategies for setting up accounts for situations that you
may not have previously considered, such as for troubleshooting
or visitors. Read Choose an Account Strategy.

Create and delete accounts:

• Set up and configure a new account. See Set Up an Account.

• Delete accounts when you need to. Read Delete an Account.

• If desired, Activate the Root Account.

Work with accounts:

• Log in and out of your account, plus customize options to simplify
or secure the login process. See Log In to and Out of Accounts.

• Use Fast User Switching to share your Mac more efficiently.

• Add and remove login items. Read Manage Login and Startup
Items.

• Use your knowledge of login and startup items to perform basic
troubleshooting. See Troubleshoot Startup and Login Items.

Share files among users:

• Choose from one of four methods for sharing files among users on
the same Mac, and set one up. See Share Files among Users.

• Share music and photos. Find out how in Appendix A: Share Digital
Media Files.
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ABOUT USER ACCOUNTS

User accounts are at the heart of any Unix-based operating system,
including Mac OS X. The entire system relies on this concept, so hav-
ing a basic understanding of what accounts are and why you need
them will help you better comprehend and use Mac OS X.

Since Unix-based operating systems rely on the concepts of permis-
sions and ownership, each file, folder, and application must belong
to a specific user. For this to be the case, users must be declared and
identified; hence the idea of creating unique accounts for each user,
much as every customer of a bank has a private account that no one
else can access.

When you set up or receive an account on Mac OS X, you become a
user of that computer, and you are assigned a home folder (the folder
with your name and the house icon). Your home folder is the recep-
tacle for your personal files, and, under Mac OS X, it contains a num-
ber of sub-folders that help you further organize your files.

Because your files belong to you, other users cannot access files con-
tained in the sub-folders of your home folder; this is also true in the
other direction: you cannot access files in other users’ folders. To help
users on the same Mac share files, each home folder contains a Public
folder, from which any user can copy files, and this folder contains a
Drop Box folder, into which any user can copy files.

This multi-user focus is quite different from earlier versions of the
classic Mac OS, which generally assumed that any user of the com-
puter could access all its files. You could set up multiple users for file
sharing over a network, but for the most part, you couldn’t limit what
other users of the same computer could do. In particular, you could
put files anyplace on the computer, and anyone could access them
when they started working on the Mac.

In addition to segregating files among users, Unix-based operating
systems prohibit standard users from accessing, changing, or deleting
essential system files. This prevents standard users from damaging
the operating system. Administrators, however, can access all files
on a computer. I talk more about this distinction later in Types of
Accounts.
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NOTE WHAT ARE PERMISSIONS?
Permissions are special bits in files and folders that tell your Mac
who owns a file; what rights they have: read (view a file, open a fol-
der, or access an application), write (view a file and save changes,
or create new files in a folder), execute (launch a program); and what
others can do with the item. The term privileges means the same
thing as permissions.

Working with Accounts
When you log in to your Mac, and create files with an application,
these files adopt the ownership and permissions for your account.
They are flagged as being your files, and other users cannot access
them. (I tell you how to make files available to others later in Share
Files among Users.)

In addition, when you log in to your Mac, Mac OS X and applications
use the preference files in your home folder, so you work with the spe-
cific settings you chose. (You don’t have to look at that ugly green
Desktop background that someone else likes, and you don’t have to
change the display of your email program each time you open it.)

Even if you’re the only person who uses your Mac, you must still have
an account. And if others in your family or office share your Mac, you
can easily set up accounts for them and enjoy numerous advantages:

• Users don’t have to (and can’t) see each other’s files.

• Standard users cannot access essential system files and cannot
damage the operating system.

• Users can have individual preferences, ranging from Desktop
backgrounds to Web browser bookmarks.

• Users don’t have to worry about others checking or reading their
private email messages.

• You can set limitations on what users can access in the Finder and
system; for example, you can set a child’s account so she sees only
a Simple Finder, or other accounts so their users can use only cer-
tain applications.
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• You can use parental controls for some Apple applications—Mail,
iChat, Safari, and Dictionary—in order to restrict who a user can
communicate with, which Web pages a user can visit, and which
words a user can look up.

What’s New in Tiger
If you’ve worked with accounts in Mac OS X 10.3 Panther, you’ll find
some changes in the way Tiger lets you configure accounts:

• Options that you previously set in Panther in the Accounts system
preferences, on the Security pane, have been moved to the Security
preference pane.

• Startup items are once again called login items. (See sidebar Login
Items and Startup Items, on the next page, for more on this termi-
nology.)

• A new pane, Parental Controls, in Accounts system preferences,
replaces the Limitations pane that was visible only when you
selected non-administrator accounts in Panther. It is now present
for all accounts, though if you click it when an administrator's
account is selected, you'll see nothing more than a message telling
you that you cannot turn on parental controls for that account.

• Panther distinguished between managed accounts and simplified
accounts. The difference between the two was that simplified
accounts could only access a Simple Finder, whereas a managed
account was one for which some limitations were set. In Tiger,
both of these accounts types are called managed accounts. Types
of Accounts explains the accounts types and the Simple Finder.

• Application-specific limitations: Panther limited you to Finder
and System limitations; you could choose Simple Finder, limit
access to specific applications, and disallow access to certain
settings. Now, Tiger goes further by offering controls for certain
Apple applications. Read Set Parental Controls to learn more.

• The login window can now be configured to allow you to change
keyboard layouts or to work with the VoiceOver, a utility that
speaks the interface. See Customize the Login Window.
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SIDEBAR LOGIN ITEMS AND STARTUP ITEMS

Over time, Apple has shifted the terminology for these items, much to
the annoyance of many long-time Mac users.

• Jaguar (Mac OS X 10.2): Under Jaguar, login items were appli-
cations, documents, or folders that became active, launched, or
opened when you logged into your account. Along with login items,
Jaguar provided startup items—low-level programs that activate
when the Mac starts up. These startup items, which remained in
Panther, are like the extensions of the classic Mac OS, and affect
the Mac as a whole, no matter which user is logged in.

• Panther (Mac OS X 10.3): In Panther, Apple began calling both
of these “startup items.”

• Tiger (Mac OS X 10.4): Finally, in Tiger, Apple has gone back
to the Jaguar method, and has allowed logic to rule terminology—
items users can set in the Accounts preference pane are login items
(see Set Login Items). In contrast, items that affect the entire Mac
are startup items (see Manage Startup Items).
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TYPES OF ACCOUNTS

Tiger offers three normal types of accounts: administrator accounts,
standard accounts, and managed accounts. (A special fourth type of
account, called root, is not accessible from the Accounts preference
pane.)

You can see the types of accounts set up on your Macintosh by view-
ing the Accounts pane in System Preferences, as shown in Figure 1.
(To open System Preferences, choose it from the Apple menu or click
its icon in the Dock.)

FIGURE 1 A quick look at the left side of the
Accounts pane in System Preferences
reveals which accounts are set up on
the Macintosh. You can see the user
name for each account and which type
of account it is: admin, standard, or
managed.

Before you start creating new accounts, you need to understand these
different account types, what rights each one has, and how you would
use each type. Table 1 (next page) summarizes the powers and limit-
ations of these accounts, Table 2 helps you quickly match different
types of users to the different types of accounts, and the rest of this
section explains the account types in more detail.

NOTE Technically speaking, managed accounts are merely a variant of stan-
dard accounts, but I follow the example of the Accounts preference
pane which uses both terms in its interface.
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Table 1: Overview of What Account Owners Can Do

Account
Type Account Owner Can Account Owner Cannot

Root • Do anything. • Be sure his actions
won’t be serious
mistakes.

Administrator • Create and delete other accounts.

• Install any software.

• Change permissions on files and folders.

• Access secure system preferences.

• Add fonts for all users.

• Access mounted volumes on remote Macs
where he has an account.

• Create folders in locations other than his
home folder.

• Run certain utilities.

• Access, change, or delete any file.

• Run the sudo command in Terminal.

• Be sure that his actions
won’t be serious
mistakes.

Standard • Access files in her home folder or its sub-
folders.

• Access other users’ public folders.

• Access folders on shared volumes.

• Change settings in non-secure system
preferences.

• Install software for personal use.

• Install software for all
users.

• Access all files and
folders.

• Change settings in
secure System
Preferences panes.

Managed • Do everything that standard accounts can
do, except for limits applied by the
administrator, called parental controls.

• Access only a simplified Finder, if the
administrator chooses this in the Parental
Controls pane.

• Make changes to certain
settings, according to
the parental controls
applied.

• Access applications that
the administrator has
not allowed.

• Access unapproved Web
sites, exchange email or
chat with unapproved
people.
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NOTE Panther distinguished between managed accounts and simplified
accounts. In Tiger, both of these types of accounts are called managed
accounts. The difference between the two was that simplified accounts
could only access a Simple Finder (see later in Simplified Account for
more on the Simple Finder), whereas a managed account was one for
which there were some limitations set.

Table 2: How to Match Account Types to User Types

Account
Type Works Well For

Root A super-user who needs access to every file and every program and
service on the Mac.

Administrator The person who manages the Macintosh by installing software, creating
user accounts, and solving problems when things go wrong.

Standard Everyday users who need to access files in a home folder, run software,
create documents, and share files with other users on the Mac.

Managed Users whose access should be restricted, either to prevent harm to the
system or to limit what they can do with the computer. For instance, a
managed user might have a special, limited Dock or be unable to receive
email from unapproved correspondents.

Administrator Account
An administrator is, in the Unix world, a person who manages a
computer or a group of computers. Administrators have accounts that
give them the power to make system-wide changes, create, manage,
and delete user accounts, and change settings that normal users can’t
access. In Tiger, administrators have all these rights and more.

After you first install Mac OS X, or when you first turn on a new Mac,
the Mac OS X Setup Assistant greets you and walks you through the
setup process. You may not realize it, but when this assistant asks for
a user name and password to create your first account, it sets up an
account for you with administrator status.

This makes sense, because if you are the only user on your Mac you
must be its administrator; if not, you won’t be able to access all its
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settings, install software, or perform other administrative tasks
required to maintain your Mac.

In addition to accessing her own files (which is true of all account
types), an administrator can do the following:

• Create, manage, and delete user accounts.

• Change permissions for files and folders.

• Access secure parts of System Preferences, and make changes that
affect global system operations.

• Install all software using the Apple Installer or third-party install-
ers. (Some programs don’t require authentication for installation
and others can be installed by simply copying them to any folder.)

• Add fonts to the /Library/Fonts folder, to provide system-wide
access. (A standard user can add fonts to his ~/Library/Fonts
folder, so he can use these fonts, but other users can’t use them,
unless they install them in their own ~/Library/Fonts folders.)

• Create new folders in locations on the startup volume other than
inside her home folder.

• Access mounted remote volumes on a Mac where she has an ad-
ministrator account. Non-administrators can access only their
home folders and other users’ Public folders, but users with ad-
ministrator accounts on the Mac they connect to can also access
any mounted volumes: internal or external hard disks, mounted
network volumes, and even an iDisk mounted on another Mac.

• Access certain system-level utilities, such as NetInfo Manager and
Directory Access. (See the sidebar on the next page for details.)

• Access, change, or delete any files on the Mac. If you want to ac-
cess, change, or delete files in the System or Library folders you
are prompted to authenticate, and you can enter your administra-
tor password to carry out the task. This approach has pros and
cons. It’s great to be able to access restricted files and folders with-
out dropping into Terminal and using the command line, but since
the first account on any Mac is an administrator account, this gives
many people the power to make potentially damaging mistakes.
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SIDEBAR RANT: STANDARD USERS CAN USE DISK UTILITY

I remain amazed that any user can use Disk Utility, which is powerful
and dangerous since you can use it to erase any disks other than the
startup disk. In Jaguar, only administrators could use Disk Utility.
But from Panther onward, Apple decided to roll the functions previ-
ously in Disk Copy (which lets you create and work with disk images)
into Disk Utility, requiring that it be accessible to standard users.

I find it surprising that Apple allows any user to access Disk Utility
without even requiring authentication for Disk Utility’s more danger-
ous functions, such as erasing, partitioning, and reformatting disks.
If you manage Macs in a school, company, or lab setting, I recom-
mend that you prevent users from accessing Disk Utility. (I explain
how to do this later, in Set Parental Controls.) Otherwise you risk
having a bored student or disgruntled employee figure out how to
wreak havoc with Disk Utility.

Standard Account
As I discussed just earlier, administrators have virtually unlimited
power in working with a Mac. In contrast, standard users have far less
power. However, a standard user can:

• Access any files in his home folder or its sub-folders, creating new
files and deleting others, and creating new folders at any location
within his home folder.

• Access the Mac’s Shared folder, as well as the Public folders of any
other users on the same Mac, and copy files from these folders to
his own home folder. He can also copy files to the Drop Box folders
inside other users’ Public folders.

• Copy files to and from, as well as create folders on, shared volumes
where permissions have been ignored. (See Share Files via a
Shared Volume for more on ignoring permissions on a volume.)

• Change settings in non-secure panes in System Preferences such as
Appearance, Desktop & Screen Saver, Dock, Dashboard & Exposé,
Sound, and .Mac. He cannot, however, change preferences that
affect the overall system, such as those in Network, Sharing, or
Startup Disk.
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NOTE It may not always seem that way, but there is a logic to Apple’s use
of preference panes that present some protected functions that are
accessible only to administrators and some unprotected functions
that can be changed by any user. Take the Print & Fax preference
pane: standard users can change the default printer and paper size,
set up printers, and turn on faxing, but they cannot change any set-
tings on the Sharing tab, since these settings affect the entire comput-
er. The Security pane is another example; standard users can adjust
FileVault settings, but they cannot make changes in the bottom part
of the Security pane that affect all accounts on the computer. Rather
than split such related functions among several preference panes,
Apple grouped them and limited access to aspects that impact the
computer as a whole.

Managed Account
When you set limits to a standard user’s account, the account be-
comes a managed account, as shown in Figure 2. Limits may be
minor, such as not allowing the user to burn CDs or DVDs, or more
wide-ranging, such as limiting the user’s access to certain programs.

You set limits (which Tiger calls parental controls), in the Parental
Controls pane of the Accounts system preferences. A big change in
Tiger, as far as user accounts is concerned, is the new capability to
limit certain aspects of using Mail, iChat, Safari, and Dictionary
(Figure 2, next page).

Simplified Account
Even though Tiger no longer uses the term “simplified account,” I
think it's useful to keep this name for an account that is set to use
only Simple Finder. An account with this type of parental control has
a different interface and very different rights from other managed
accounts.
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FIGURE 2

The Parental Controls pane, showing the different applications for
which you can set limitations.

With Simple Finder running, as shown in Figure 3 (next page), the
user sees only a minimal Dock and can access only applications in the
My Applications folder in the Dock. (When you set up the account,
you can choose which applications she can use.) This is the best way
to set up a user account for a young child.

If an administrator, needs to access files or perform other operations
when a user is running Simple Finder, he can choose Finder > Run
Full Finder, then authenticating. This switches the interface to the
normal Finder, with the exception of the Dock, which remains as
shown in Figure 3 (next page). This allows the administrator to copy
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FIGURE 3

The Simple Finder is truly simple. The Dock contains three folders:
My Applications, My Documents, and Shared. My Applications,
whose window is shown above, contains aliases to the applications
the user is allowed to access. My Documents, the middle folder
you see in the Dock, lets the user store personal documents, and
Shared, the rightmost folder in the Dock (the /Users/Shared fol-
der), lets the user share documents with other users.

files, for example, from a shared volume to the user’s Documents
folder. Choosing Finder > Return to Simple Finder switches back to
the minimal Finder access.

Root Account
The root account is a special superuser account available on all Unix-
based systems. The root user has the ultimate power to access and
change any files, or to perform any operations on the system without
authenticating. The root account is authorized to do anything.

You do not access or configure the root account in the Accounts pref-
erence pane; the root user account exists automatically on Mac OS X.
See Activate the Root Account to learn more about using the root
account.
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CHOOSE AN ACCOUNT STRATEGY

The number of accounts you set up depends not only on how many
users you have, but how you want to work with your Mac. Here’s how
I recommend setting up accounts for several different scenarios.

Single User Mac
Even if you’re the only person who uses your Mac, I recommend that
you create one or two additional accounts for security and trouble-
shooting.

Set up a standard account for everyday work
If you work alone on your Mac, consider setting up a standard ac-
count that you’ll use under almost all circumstances. This may seem
strange, since only administrators can install software or change cer-
tain preferences. But if you need to do these tasks, you always have
the option of authenticating as an administrator by entering the user
name and password of an administrator account, even while you are
logged into your standard account.

This technique provides extra peace of mind, since it’s almost impos-
sible to damage your system as a standard user if you work like this
(though if you authenticate as an administrator you have the added
power to screw things up). I think that the peace of mind is more im-
portant than the potential annoyances, such as an increased number
of authentication requests and having to log in to your administrator
account to create folders outside of your home folder.

NOTE HOW TO AUTHENTICATE

Authenticate, a rather fancy sounding term, simply means “enter
your user name and/or password.” The login window, which appears
when you log in to your Mac, is an authentication request. You’ll see
an authentication dialog if you try to access, change, or delete certain
files, or perform other tasks, such as installing some software.
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Set up a troubleshooting account
Whether or not you decide to use a standard account for everyday
work, you should create a second administrator account. If something
goes wrong with your everyday account, you can log in with the trou-
bleshooting account to see if the problem recurs. If the problem dis-
appears when you’re logged in with your troubleshooting account,
you can be pretty sure that your problem has something to do with
software or preferences that affect only your main account. See
Troubleshoot Startup and Login Items and Troubleshoot Preference
Files for information about using your troubleshooting account.

Set up a guest account
You may want to set up a standard account for guests, so friends or
family who need to use your Mac for “just a few minutes” can do so
without accessing your files or changing your settings. A guest can use
your software, such as a Web browser, but won’t be able to access
your email or bookmarks.

NOTE If you are a developer, or work with software as a beta tester, you
might want to create a special administrator or standard account
(depending on the capabilities you need) for testing. Using a testing
account protects your main account from corruption, and when you
finish testing, you can just delete the account. You can also be sure
that your testing account is a virgin account with no changes made
from the default installation. With Fast User Switching (discussed in
Fast User Switching) you can quickly switch to your testing account
when you need to.

Multi-User Mac at Home
If you share your Mac with your family, you may or may not find it
useful to have individual accounts for each user. Some families find
that sharing a single account makes it easier to work at home. Each
user has access to the same files, such as photos, bookmarks, and
music files, so there’s no need to worry about sharing files among
users. If you share your a Mac with just one other person, relying
on a single account may be the easiest approach.

However, here are some reasons for setting up individual accounts:
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• Privacy: You can’t see each other’s files, email accounts remain
separate, and everyone’s settings and preferences stay indepen-
dent. If any of your users want privacy—and any parent of a teen-
ager knows this is essential—you should create separate accounts.

• Peace of mind/ease of use: If you don’t want to give a user—
such as a young child—full run of your Mac, you should create an
account for her. Using a managed or simplified account not only
protects your Mac from mistakes, but can also be less overwhelm-
ing for children.

• Restricting unapproved content: You can set parental con-
trols for children who use your Macintosh, protecting them from
undesired content, and preventing them from chatting or emailing
with unapproved people.

• Remote troubleshooting: If the friend or relative who acts as a
troubleshooting guru isn’t often in your home, you can set him up
with his own administrator account. This enables him to connect
to your Mac remotely over the Internet to perform some trouble-
shooting tasks, even if he is far away. He could connect remotely
using the command line via ssh or using remote-control software
described in the tip, next.

TIP Using ssh requires Unix skills, and connecting to a Mac via ssh does
not provide full access to Mac OS X. A better way of enabling remote
troubleshooting for your far-away guru is to install remote-control
software like Netopia’s Timbuktu Pro ($150 for a twin-pack), which
lets someone work on your Mac just as though that person was sitting
in front of it. For decent results, you need a high-speed Internet
connection (http://www.netopia.com/software/products/tb2/).

Another possibility is to use a VNC client (such as Chicken of the
VNC; http://sourceforge.net/projects/cotvnc/), which provides
similar functions for free. If you do this, you’ll need to turn on Apple
Remote Desktop in the Sharing preference pane, then, with Apple
Remote Desktop selected, click Access Privileges, and check VNC
Viewers May Control Screen with Password. Enter a password, and
you’ll then be able to connect to the Mac and control it remotely.

http://www.netopia.com/software/products/tb2/
http://sourceforge.net/projects/cotvnc/
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TIP If you use your Mac to share files with remote users who might log in
from either the same network or via the Internet, adding an account
that covers all of them (in some situations) or providing individual
accounts for each of them may be a big time saver. Turning on and
administering file sharing is a huge topic worthy of its own Take
Control ebook; check out Glenn Fleishman’s Take Control of Sharing
Files in Tiger for the details.
http://www.takecontrolbooks.com/tiger-sharing.html

Multi-User Mac in an Office or School
If you share a Mac with other users in a public setting such as a school
or office, I strongly recommend that the machine be set up with a
standard, managed, or simplified account for each user. The adminis-
trator should create and manage these accounts, setting limitations as
appropriate for each user.

The primary administrator should also create a second, backup
administrator account that could be used when she is unavailable.
Remember, only administrators can install software for all users and
updates to Mac OS X, so it’s important that someone be able to do
this when required, even if the administrator is on vacation.

http://www.takecontrolbooks.com/tiger-sharing.html
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CREATE AND DELETE ACCOUNTS

If you’ve read this far, you’ve learned about the four types of accounts
(see Types of Accounts, earlier) and you’ve seen my recommendations
for setting up accounts on your Mac, so you’re in good shape for
creating additional accounts and for deleting unnecessary accounts.

NOTE Although you can create accounts from the command line, I don’t
recommend it for typical readers of this ebook because it is more
complex than using System Preferences and more prone to problems.
However, I do explain how in my book The Mac OS X Command
Line: Unix Under the Hood.
http://www.mcelhearn.com/unix.html

Set Up an Account
Follow these steps to create an account:

1. In System Preferences, click the Accounts icon, then click the lock
icon and enter your administrator’s user name and password to
authenticate. Click the + (plus) button beneath the account list.
(To open System Preferences, choose it from the Apple menu or
from the Dock.)

A dialog appears, with the insertion point in the Name field.

2. Enter a name for your user. The Name field holds the user’s long
name, or full name. (The user’s long name is his real name; the
short name is used for the name of his home folder, and need not
relate to the long name.)

3. Enter a short name in the Short Name field. By default, Mac OS X
enters your user’s long name without spaces in lowercase. You do
not have to keep this default name; in fact, the point of having a
short name is that it is, well, short. You can’t change the short
name later—at least not easily—so make sure you choose the right
short name now. It could be the user’s first name, a nickname, or
anything else you choose.

4. Enter a password, enter it again in the Verify field, and enter a hint
if you want. The hint displays if the user types an incorrect pass-
word in the login window three times.

http://www.mcelhearn.com/unix.html
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TIP If you want to use Fast User Switching, which I discuss later, and
avoid entering a password each time you switch users, you can set
blank passwords for your users. Normally, Fast User Switching re-
quires that a user enter a password to switch to her account, but if a
user account has a blank password, you can switch to it immediately,
bypassing the login window. If you’re setting up accounts for family
members, and you’re unconcerned about security, I recommend that
you create accounts with blank passwords; just leave the Password
and Verify fields blank when you set up their accounts. Tiger warns
you of the security risk when you do this.

5. To turn the account into an administrator account, check Allow
User to Administer This Computer. (You can also make this
change at any time from the Password pane of any user’s account.)

6. Click Create Account to add the new account to the accounts list.

7. Click the Picture tab and choose a picture from the Apple Pictures,
or drag a picture file from a Finder window, or from the Desktop,
into the Picture box. You can use most types of graphics files, in-
cluding JPEG, GIF, TIFF, PNG, and PDF; and you can take a video
snapshot if you have a digital video camera.

TIP To use a photo from iPhoto, first drag it from iPhoto to the Desktop,
then from the Desktop into the Picture box, where you must adjust
the slider to get the right part of the photo to fit.

8. To turn on parental controls, and make this account into a man-
aged account, click the Parental Controls tab. See Set Parental
Controls, ahead, for information on configuring the different
limitations.

The Accounts preference pane lacks a Save button; it records changes
as you make them and applies them when you close the preference
pane or click another tab or another user name in the account list.
There’s also no Cancel button, so if you decide you don’t want to
apply your changes you must undo them manually.
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TIP Several readers have asked how to change the short user name of
an account. Although you can’t change the short user name from
the Accounts preference pane, it can be done, and it is a complex
procedure—a technical article from Apple (see http://docs.info.apple.
com/article.html?artnum=106824) describes the technique in 39
steps. Suffice it to say that I recommend following those 39 steps only
to users who are very comfortable with tweaking their systems, and
who have backed up their data. Twice.

But there’s another way to accomplish the desired result of changing
an account’s short user name. Start by creating a new account with
the desired short user name. Copy the contents of the existing ac-
count into the /Users/Shared folder. Log out, then log in to the
new account and replace the contents of the new account’s home fol-
der with the folders you placed in the Shared folder. Log out and log
in again so Mac OS X reads the new user preference files that you just
copied from /Users/Shared.

Set Parental Controls
Now that you’ve set up an account, you may wish to limit what the
account owner can do. In this section, I explain how to configure the
Parental Controls pane, in the Accounts system preferences.

TIP Don’t worry if you aren’t sure exactly how you want to set up these
controls at first. Y0u can go back and modify them later.

Finder & System controls
Finder & System is not the first item in the Parental Controls list, but
I look at it first, since it determines whether the account is managed
or simplified. Follow these steps:

1. Check Finder & System and click Configure:

• To create a managed account: First, select the Some Limits
radio button. Then, check any desired checkboxes. In particular,
to allow the user to access only specific applications, check This
User Can Only Use These Applications, and provide access to a
program by checking its Allow checkbox. (View the contents of a

http://docs.info.apple.com/article.html?artnum=106824
http://docs.info.apple.com/article.html?artnum=106824
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listed folder by clicking its expansion triangle.) To give access to
an unlisted program, click Locate, then navigate to find it. Click
Add to add it to the Others section and grant access (Figure 4).

FIGURE 4

Choose which applications you want to allow the user to access by
selecting them in the bottom section of this dialog.

The Allow Supporting Programs checkbox is important—if you
check it, a program that you have allowed can cause another
program (that you have not allowed) to open. This is important
for some programs, since they call on “hidden” programs that
run in the background, or they may need to launch special pro-
cesses to support their functions. However, checking this option
has a downside: read the sidebar Application Limits Don’t
Always Work for more info.
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• To create a simplified account: Select the Simple Finder
radio button. Then, provide access to a program by checking its
Allow checkbox. (View the contents of a listed folder by clicking
its expansion triangle.) To give access to an unlisted program,
click Locate, then navigate to find it. Click Add to add it to the
Others section and grant access (Figure 5).

FIGURE 5 When you apply Simple
Finder to a user, you can
set which applications
the user can access. By
default, all applications
are inaccessible. Click
an expansion triangle to
show the contents of a
folder or of the Others
category, and then
check an application’s
checkbox to allow
access.

2. Click OK to save your changes.

TIP When you set up a simplified account, the applications you select in
the Simple Finder section show up in the My Applications folder on
the user’s Dock. You can see how they look in Figure 3.
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SIDEBAR APPLICATION LIMITS DON’T ALWAYS WORK

When setting up a managed account, if you check This User Can Only
Use These Applications, the user is initially allowed to use the pro-
grams in either Applications folder, but no utilities in the Utilities
folder. This is one way to prevent users from fiddling with Disk
Utility, which can be dangerous, as I mentioned earlier in the sidebar
Rant: Standard Users Can Use Disk Utility.

However, blocking access to individual programs does not offer iron-
clad protection. Although it prevents users from opening applications
by double-clicking them, if you check Allow Supporting Programs,
other applications can still cause blocked applications to open.

Here’s an example. If you don’t allow a user to run Safari, yet you
check Allow Supporting Programs, other programs will be able to
launch Safari. Safari could launch, for instance, if a user ran iTunes
and clicked a Web link in the iTunes Music Store.

To fully protect access to certain software, but still allow supporting
programs to run (which you may need to do, especially for games),
you must do some sleight of hand. First, log in as an administrator.
Then, in the Finder, select the application you want to block and
choose File > Get Info (Command-I). In the Info window, open
Ownership & Permissions and open Details. Click the lock next to
Owner, and change the owner to your user name. You may need to
authenticate. From the Others pop-up menu, choose No Access.
Finally, close the Info window.

Now, only your account can access the selected application. You can
always go back and change the owner to System again, giving Others
Read & Read Only access. And, in fact, if you change permissions in
this manner for an Apple application, you must reset the permissions
to their original values before running any system updates. If not,
they might not update correctly. If you don’t want to return to the
Info window, perhaps because you changed several Apple applica-
tions and it would be repetitive to change each one in the Info win-
dow, you can reset the permissions by repairing permissions with
Disk Utility.
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Mail controls
To set limitations for Mail, check Mail and click Configure to open
a dialog where you can add email addresses with which the user can
exchange email (Figure 6). This works as a whitelist; the user can
send email only to and receive messages only from addresses in the
list.

FIGURE 6

Click the + (plus) icon to add a user to the whitelist. If you check
Send Permission Emails To, you can enter your address to receive
messages for your approval before they go to the user.

iChat controls
Just as you can set up a whitelist with Mail, you can set up an iChat
whitelist, thus controlling who your user can contact by iChat.
(However, you can’t control the type of chats he can have with iChat,
such as audio and video chats, nor can you block him from sending or
receiving files or graphics.)

Check the iChat box; then click Configure. To add a contact to the list,
click the + (plus) button. This opens a Buddies dialog where you can
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add known buddies by selecting them and clicking Select Buddy, or
where you can add unknown buddies by clicking New Person.

Safari controls
Similar to the types of whitelists you can set up for Mail and iChat,
you can set up a whitelist of Web sites that your user can access with
Safari. Here are the steps:

1. Check the box next to Safari, and click Configure. You’ll see a
dialog telling you to log in as that user.

2.  Log out. Then, log in as the user who you want to make a whitelist
for. (If you know how, use Fast User Switching do this quickly.)

3. Launch Safari.

4. Try to visit a Web site that you want to add. Safari will display a
page saying that it is limited by parental controls.

5. Click Add Website to add the URL to the bookmarks bar; then
enter your administrator user name and password and click OK.

6. Edit the bookmark name, if you like; then click Add to add it to
the bookmarks bar. (You can add bookmarks only to the book-
marks bar, not to the bookmarks menu; when Safari is set up
with parental controls, the bookmarks menu is unavailable.)

TIP You may want to remove the default bookmarks that Apple includes
in the bookmarks bar: these include Amazon.com, eBay, Yahoo, and
several news sites. To do this, hold down the Command key and drag
a bookmark off the bar. You’ll be prompted to authenticate.

You can also manage bookmarks by clicking the Show All Bookmarks
button at the left of the bookmarks bar (it looks like padlock nesting
inside a book). Safari will prompt you for authentication.

7. Log out of the managed user’s account and return to your adminis-
trator’s account.

NOTE In the Parental Controls pane, the Configure button for Safari is bo-
gus; even after you add URLs to the user’s bookmarks bar, you can
still make changes only by logging into the account.
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Dictionary controls
To prevent a user from reading the definitions of “certain words, such
as some profanity,” check the Dictionary box. The user will be able to
look up these words, and will see a list of the words contained in the
dictionary, but will not be able to access their definitions.

RANT While I understand that some parents and teachers may want to iso-
late users from disturbing words, the futility of such a procedure is
evident. Nothing prevents users from looking up such words in a
paper dictionary, at home or in the library, nor from searching for
their definitions on the Web. Further, the fact that Dictionary still
displays word lists (look up the most common word you can think of
that should be blocked, and you’ll see it together with a list of combi-
nations containing that word), makes this protection risible at best.

Delete an Account
To delete an account, open the Accounts preference pane, select the
account in the Accounts list, and click the minus (–) button at the
lower left of the pane. Your Mac will display a dialog offering three
options (Figure 7):

FIGURE 7

When you delete an account, you get three options: Delete Immedi-
ately, Cancel, and OK. You also see info about what becomes of the
deleted account’s home folder.

• OK: If you click OK, Tiger deletes the account and saves its home
folder as a disk image in /Users/Deleted Users, so you can
recover the data if you need to. (Creating the disk image may take
a few minutes if the user has many files in his home folder.)
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TIP To recover data from a disk image, double-click it to mount it as a
volume on your Desktop, then copy files from it to wherever you like.
Only administrators can access the Deleted Users folder.

• Delete Immediately: If you click Delete Immediately, the ac-
count and the user’s home folder are both deleted immediately.
Don’t use Delete Immediately unless you’re deleting a test account
or other account that you’re sure contains no data worth saving.

• Cancel: If you realize that you don’t want to delete the account,
click Cancel to leave it as it was.

Activate the Root Account
As I mentioned earlier, in Root Account, the root account exists by
default in Mac OS X, but to use it you must enable it. To enable the
root account, perform the following steps:

1. Open NetInfo Manager, which is located in the /Applications/
Utilities folder.

2. Choose Security > Authenticate, and enter your user name and
password. Then choose Security > Enable Root User.

An alert appears, telling you to set a “non-trivial” password for
the root account. Take this warning seriously; setting a simple
password makes it too easy for anyone to control your Mac.

3. Click OK, and then enter the password you want to use; retype it to
confirm, and click OK.

4. You may now have to authenticate by entering your administrator
password.

To disable the root user account, return to NetInfo Manager and
choose Security > Disable Root User. You’ll be asked to authenticate,
and then the root user account will be disabled. It won’t be deleted
though, and its password won’t be erased either; you can turn it back
on later by choosing Security > Enable Root User.
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LOG IN TO AND OUT OF ACCOUNTS

If you’ve used Mac OS X at all, it’s a good bet that you already know
the basics of logging in to your account. Nevertheless, our friends
upgrading from Mac OS 9 or switching from Windows may want a
crash course.

Log In to Your Account Normally
When your Mac starts up, you first see a dark gray Apple logo on a
gray background with a gear beneath it. The gear turns a few times,
then a blue background appears. After another few seconds, a
progress window appears, with the message “Starting Mac OS X...”
Finally (unless you have automatic login turned on; see Bypass the
Login Window), the Mac displays the login window:

• Default login window: By default, the login window lists all the
users who have accounts on your Mac, with their pictures followed
by their full names. To log in to your account, click your name, and
the login window changes to show a Password field. Enter your
password, and then click Log In.

• Custom login window: If you customize the login window to
display only a Name and Password field (see next, Customize the
Login Window), you must enter your user name (either your long
user name or your short name) and your password, and then click
Log In.

If you make a mistake typing your password, the login window moves
back and forth horizontally—as if it were shaking its head “no.” Re-
type your password; you may have pressed a wrong key. Also, check
if your keyboard’s Caps Lock key is toggled on; if it is, the Password
field will show the Caps Lock symbol, an up-pointing arrow over a
horizontal line, at its far right.

Once you log in using either of these methods, any login items you set
in the Accounts preference pane activate or open. (See later, Manage
Login and Startup Items, for more on setting these.) After a few
seconds (if you have many login items this can take a minute or more)
you see your Desktop, and you can start working.

When you log in to your account using Fast User Switching, you see
essentially the same login window. After you log in, your login items
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launch or open, and you see the same thing as when you log in at
startup. The advantage of Fast User Switching over a normal login
is that when you switch to another user, then switch back to your
account, you won’t need to wait for login items to load: they remain
active when you switch users, as do any applications you were using
before you switched. This means that you can get back to work im-
mediately, without having to open files and applications that you were
using. (See Fast User Switching for more info.)

Customize the Login Window
The Accounts pane of System Preferences offers a few options for
changing the way users on your Macintosh work with the login win-
dow. To modify these settings, open the Accounts preference pane
and click Login Options at the bottom. Then:

• Change whether user names appear: The login window can
display either a list of user names and pictures or a Name field and
a Password field. The former method makes it so users need not
remember their user names; the latter method is one way to be
able to log in as root, as I discuss later in Log In as Root. Also, if
you have a lot of accounts, it may be easier to display the Name
and Password fields rather than a list of user names; users won’t
have to scroll through a long list to find the desired name. To
change the login window display, simply select the desired Display
Login Window As radio button.

• Prevent users from restarting, sleeping, or shutting down
via the login window: Check the relevant checkbox to turn on
this feature; it’s mostly useful in a location where many users
access the same Mac.

• Allow users to switch keyboard layouts on login: New in
Tiger, this option fixes problems in previous versions of Mac OS X
where users could not log in at all without first switching keyboard
layouts or where, even after logging in, the keyboard layout could
not be swapped, forcing users to memorize which keys, according
to a keyboard layout that is not theirs, type which letters. To acti-
vate this option, check Show Input Menu in Login Window.

• Make your Mac talk when the login window appears (via
VoiceOver): You can check Use VoiceOver at Login Window to
have your Mac speak using the VoiceOver utility, which provides
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spoken assistance, when the login window shows. For more on
VoiceOver, see the Mac OS X Help.

Bypass the Login Window
You can set up your Mac to log in automatically as a specific user,
and if you are the only user of your Mac and not particularly con-
cerned about security, I recommend this option. Be careful if you’re
in a setting where multiple users can access your computer, since
whoever turns on the Mac will have access to the selected account
and its files. If you have an iBook or PowerBook, you should probably
keep this off. If not, anyone could pick up your computer and access
your files.

To turn on automatic login, in the Accounts preference pane, click
Login Options, check the Automatically Log In As checkbox, and
choose the desired user from the pop-up menu. You must enter that
user’s password, even if you select your own account.

NOTE Logging in automatically works only when the Mac starts up; if you
log out and then log back in, you must select your user and type your
password manually.

TIP To defeat automatic login temporarily, press the Shift key right after
the Starting Mac OS X screen appears (this is the screen with the
progress bar) and hold it down until you see the login window.

Log In as Root
You probably won’t ever need to log in as root, except possibly as a
last resort when troubleshooting.

The root account never shows up in the login window like other ac-
counts, so how do you log in as root? If you enable the root account,
your login window looks different than the standard version: at the
bottom of the list (you may need to scroll down a bit if you have more
than a handful of users), you’ll see an Other icon. Click Other to dis-
play Name and Password fields in the login window. Enter root in
the Name field and your root password in the Password field, and
then click Log In.
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Alternatively, if you set the login window to display the Name and
Password fields (as explained in Customize the Login Window), you
can log in as root by entering root as the name, the root password
as the password, and then clicking Log In. (There are other ways of
logging in as the root user, such as connecting remotely via the com-
mand line, using the su or sudo commands from Terminal, or by us-
ing certain third-party applications to access files as root. However,
since Tiger lets an administrator access any files after authenticating,
you probably won’t need to employ these techniques.)

Log Out of Your Account
When you finish working on your Mac, you may wish to:

• Log out of your account. Logging out of your account—by choosing
Apple Menu > Log Out user name—closes all active applications,
and then displays a login screen.

•  Put your Mac to sleep, if you plan to use it again soon. You will
remain logged in to your account.

• Shut down your Mac (if the pulsating light doesn’t bother you).
When you shut down, Tiger first logs out of your account, then
goes through its shutdown routine. Next time you start up your
Mac, it will restart and display a login window (or not) according
to the settings applied in the Accounts preference pane (see earlier,
Customize the Login Window).

TIP Be aware of the difference between logging out and switching users
via Fast User Switching. When you log out, you shut down all your
applications, and it takes a while to log in again, especially if you have
login items set. When you switch users via Fast User Switching, your
account remains active, but in the background. You can switch back
instantly, without waiting for any login items to open, and continue
working with the same applications you were using before switching.
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FAST USER SWITCHING

Mac OS X allows you to switch from one user account to another
without first logging out of the first account. You can keep applica-
tions and documents open in the first account, switch to another
account and work in it, then switch back.

Fast User Switching is great for people who share a Mac. Say you’re
working on your Mac and your spouse or child simply has to check
his email. Rather than log out and shut down your applications, you
can switch to his account quickly, he can check his email, and then
you can switch back to your account and pick up right where you left
off. But since leaving applications open in non-active accounts uses
some memory, users of professional applications, such as memory-
hungry graphics or video programs, may find it impractical.

WARNING! Make sure you save any files you’re working on before switching to
another account. An administrator could shut down the Mac without
returning to your account and saving them, or the Mac could crash
while active in the other account.

When you turn on Fast User Switching, a User menu appears at the
far right of your menu bar, to the left of the Spotlight icon. This menu
offers commands for switching to other user accounts or displaying
the login window.

NOTE Fast User Switching offers cool eye candy on Macs that support
Quartz Extreme (all new Macs offer this support); as you switch, you
see one account change to another as a 3D cube turns, with each cube
face displaying a user’s Desktop. Video cards that support Quartz
Extreme currently include the NVIDIA GeForce2 MX, GeForce3,
GeForce4 MX, and GeForce4 Ti video cards, or any ATI AGP Radeon
card with a minimum of 16 MB VRAM. The 3D cube effect appears
only if both accounts are set to the same screen resolution in the
Displays pane of System Preferences.
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Turn On Fast User Switching
To enable Fast User Switching, open the Accounts preference pane,
click the Login Options button (at the lower left), and check the
Enable Fast User Switching checkbox. Then, choose how you want to
view the User menu in the menu bar:

• By icon: A head-and-shoulders silhouette.

• By short user name: These are also the names of each users’
home folder.

• By full name: These are the longer names used as user names on
login.

From first to last, these different options take up more menu bar
space.

TIP The User menu is a type of menu that is sometimes called a menu
extra or a status menu, and it works much like the other items at the
right of the menu bar. You can move it by pressing the Command key
and dragging it to another location in the menu bar.

Use Fast User Switching
To switch to another user’s account, choose the name of the account
you want to use from the User menu. Each time you switch to another
user you must enter the new user’s password, unless the new user has
a blank password set (see the note, next, for more details about set-
ting users up with blank passwords).
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NOTE Fast User Switching requires that each user enter a password to
switch to her account. If you’re in a family setting, and you’re not
worried about security, you can set up accounts for standard or
managed users without passwords; just don’t enter a password in
the Password and Verify fields when you set up the accounts. You’ll
see an alert warning you of the security risk when you do this. (See
Bypass the Login Window, earlier, for more information.)

Then, to switch to a user whose account has no password, just choose
the name from the User menu and the Mac will switch without dis-
playing a login window.

Don’t create an administrator’s account without a password, though;
this is a security risk, and it could lead you to make mistakes if you
change things when running that account.

TIP If you want to step away from your Mac without worrying about
someone snooping around on your Mac, either choose Login Window
from the User menu or select “Require password to wake this com-
puter from sleep or screen saver” in the Security preference pane. If
you use the latter approach, set a hot corner to activate your screen
saver in the Desktop & Screen Saver preference pane and put the
pointer in that corner to activate the screen saver before leaving your
desk. Either way, when you come back, you must enter your pass-
word to use your Mac again, but you can rest easy knowing that no
spying eyes saw or tampered with your work.

GEEK FOOD If you don’t like to waste space in your menu bar and want a different
way to invoke Fast User Switching from the command line or via an
AppleScript script, you may find this hint from Rob Griffiths’s Mac OS
X Hints Web site useful: http://www.macosxhints.com/article.php?
story=20031102031045417.

Make sure you read not only the original hint but also the comments
that follow for details of creating shell scripts and AppleScript scripts
to switch users.

http://www.macosxhints.com/article.php?story=20031102031045417
http://www.macosxhints.com/article.php?story=20031102031045417
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Limitations of Fast User Switching
There’s no such thing as a free lunch, and Fast User Switching is not
without limitations, including the following:

• When you switch from one account to another, save your docu-
ments first. If another user tries to shut down the Macintosh, she
can do so by entering an administrator name and password, but
shutting down or restarting the Mac in this manner doesn’t save
open documents in non-active accounts.

• If you want to shut down or restart the Mac, and more than one
account is open, you must enter an administrator user name and
password. This means that if Sally Administrator lets Joe Standard
User start working, but then goes out for tea, Joe won’t be able to
shut the Mac down. He’ll be able to put it to sleep, but this may not
be sufficient.

• If your Mac doesn’t have much RAM, and you have several user
accounts open, it may become sluggish as it must share memory
among the open accounts, even if they’re inactive.

• Some applications don’t work correctly with Fast User Switching,
or work for only one user at a time. In particular, applications that
access user-specific preferences for network access may have prob-
lems with multiple user accounts open.

• If you have certain programs open under one account you won’t
be able to work with them under another account. Only one user
at a time can use the Classic environment; if one user has started
Classic, other users can’t. If you use iChat, it logs out automatically
when you switch users, logging in for the new user. When you
switch back, it logs in again for the original user.

There aren’t only limitations to Fast User Switching: on the plus side,
you can use Fast User Switching to open one account, launch iTunes
or iPhoto, then switch back to the first account and access these
programs’ shared music or shared photo libraries.
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SIDEBAR HOW TO QUIT PROGRAMS RUNNING IN OTHER ACCOUNTS

What if you need to quit an application that another user left run-
ning? If you’re an administrator, you can do that with the Activity
Monitor, found in the /Applications/Utilities folder. Activity
Monitor displays all active processes, regardless of who launched
which programs.

So if you want to use a single-user application such as iTunes, select
it in Activity Monitor and click the Quit Process button in the toolbar
to force-quit the program. You can also force-quit Classic mode using
Activity Monitor, but there is the chance that the user who left it ac-
tive did not save her work.

Be sure to impress upon all users that they should always save their
work before allowing another user to log in; force-quitting programs
does so without saving open files.
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MANAGE LOGIN AND STARTUP ITEMS

Mac OS X has two types of items that it launches at startup or at log-
in. The names Apple uses for these items has fluctuated in previous
versions of Mac OS X; in Tiger, Apple has returned to a more logical
naming convention:

• Login items are applications, documents, or folders that become
active, launched, or open when you log in to your account, whether
at startup or later.

• Along with login items, Mac OS X has startup items—low-level
programs that activate when the Mac starts up, before any users
log in. These startup items are akin to the extensions of Mac OS 9
and earlier, and include drivers, kernel extensions, network ser-
vices, and other items that affect the Mac as a whole, no matter
which user is logged in.

Both login and startup items play important roles in the operation
(or lack thereof) of your Mac, and troubleshooting problems they
may cause requires using different accounts.

Set Login Items
My earlier discussion of setting up user accounts, Set Up an Account,
doesn’t mention the Login Items pane in the Accounts system pref-
erences (Figure 8). You can view this pane only for your own account.

FIGURE 8 The Login Items
pane in Accounts
system preferences
lists items that open
automatically on
login. The first three
items shown here
are programs; iCal
will be hidden after it
opens. Fourth in the
list is a document.
Then comes my
Documents folder,
and then my iDisk.
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NOTE Don’t be surprised if you find items in the Login Items list that you
didn’t add manually. Some installers, especially those for peripherals
such as mice, trackballs, or keyboards, add items here so that their
software launches when you log in. This software runs in the back-
ground, and has no windows, so you may not be aware that it is
active. For example, on my iBook, I have login items such as Micro-
softKeyboardHelper, which starts the driver for my Microsoft Natural
keyboard; iTunesHelper, a background process used by iTunes; and
PowerMateDriver, which allows my PowerMate to function.

Add login items
To add an application, document, or folder to your Login Items list,
click the plus (+) button at the lower left of the Login Items pane,
navigate to your item, and click Add. Alternatively, you can add items
by dragging them from the Finder into the Login Items list.

Set as many login items as you want. You can set files you are cur-
rently working on to open at login, and remove them from the Login
Items list when you no longer need them. However, if you set many
applications as login items your Mac may take several minutes to
open all the programs when you log in. Some people prefer waiting
longer at login for many login items to open, whereas others prefer
to wait for shorter chunks of time when they actually need a given
program.

To open an application at login and then hide its windows after it
launches, check the Hide checkbox for that item. The item’s windows
will appear briefly as they open, then disappear. To view the hidden
windows, click the application’s icon in the Dock. Hiding windows for
login items is useful for programs such as iCal, which you want open
to display reminders, but whose window you don’t need to see all the
time. A few applications ignore the Hide setting, and won’t hide even
if you tell them to do so.

ADD LOGIN

ITEMS FROM

THE DOCK

You don’t have to go to the Accounts preferences pane to add login
items. You can add any item that is in the Dock to the Login Items list
easily: just click and hold its icon, then choose Open at Login from
the shortcut menu that opens.
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ADD LOGIN

ITEMS FROM

THE

COMMAND

LINE

While users can view only their own Login Items pane, administra-
tors can add login items from the command line.

A hint on the Mac OS X Hints Web site explains how:
http://www.macosxhints.com/article.php?story=200503160207388
29.

TIP To launch Classic at login, log in to the account in question, open
the Classic pane in System Preferences, and check Start Classic When
You Login. Or, add a Classic application or a document that uses a
Classic application to the Login Items list.

NOTE Occasionally, an installer will delete the login items entries from your
Accounts preference pane. This has happened to me on several occas-
ions, and, since some login items are background applications that
are required to control peripherals or specific programs, you may not
know where to find them to add them back if necessary.

You can find the paths to these login items in a preference file, found
at ~/Library/Preferences/loginwindow.plist. It’s a good
idea to back this file up from time to time, in case you lose your login
items entries after installing or upgrading software.

To view the file, double-click it to open it in Property List Editor.
(Property List Editor is part of Xcode Tools; if it is installed, you’ll
find it in /Developer/Applications/Utilities. If it’s not
installed, you can install it from your Tiger install disc: open
XcodeTools.mpkg, located in the Xcode Tools folder.)

After you open loginwindow.plist, don’t worry if the contents
look confusing; instead, click the Dump button to open a pane at the
bottom of the window, where, among many lines of text and odd
characters, you’ll see the paths of your login items, presented like
this:
<key>Path</key>

<string>/Applications/iChat.app</string>

Once you know the paths, you can locate your login items and add
them back to the Accounts preference pane if necessary.

http://www.macosxhints.com/article.php?story=20050316020738829
http://www.macosxhints.com/article.php?story=20050316020738829
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Mount servers at login
You can use login items to mount network volumes at startup. In
many cases this can be a good way to connect effortlessly to a network
server that you work with all the time. In Tiger, follow these steps for
best results:

1. Click the Network icon in a Finder window sidebar to find the ser-
ver you want to connect to and double-click its icon to display the
server authentication dialog.

2. Enter the user name and password you use to log in on that server
(they may be different than your local user name and password).

3. Check Remember Password in Keychain, and click Connect to
display the volume selection dialog.

4. Select the volume(s) you wish to mount, and click OK to mount
those volumes. The volume(s) will display in the sidebar of any
Finder window (and may also display on the Desktop if that setting
is on in the Finder’s preferences).

5. In the Login Items pane of Accounts system preferences, add the
volume as you would any other login item, by using the + (plus)
button or dragging its icon in from the Desktop. (Don’t drag it
from a sidebar; all that does is remove the volume’s icon from
your sidebar.)

WARNING! In principle, mounting server volumes at login is a great idea; in
practice, it can be problematic unless you’re mounting a server that
is guaranteed to be available. I tried several ways of connecting to
servers, and, while connecting to an AppleShare, Samba (SMB), or
FTP server works fine if the server is available, problems arise if the
server is down or off. Sometimes, the Mac looking for the server
would log in and display an AFP Connection Status window as it
searched for the server, and eventually time out, displaying an alert
that the connection failed. Other times, it would just wait at the be-
ginning of the login process, after displaying the Desktop back-
ground, offering no way to move on. If the server became available,
then it would proceed, but if not, I had to force-restart my Mac.
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NOTE The preceding steps for adding a server to your login items are for
Mac OS X 10.4 or later; in some early versions of Mac OS X 10.3, you
must instead mount the server by entering its IP address in the Con-
nect to Server dialog—Choose Go > Connect to Server (Command-K)
in the Finder.

Delete login items
To remove any item from the Login Items list, click it to select it, then
click the minus (–) button. This doesn’t delete the original file; it just
removes it from the list of items that launch automatically. You may
want to do this when you finish a specific project, and no longer need
to open items related to that project. You may also want to delete
login items if you have problems when your Mac logs you in, and you
suspect that an application opening at login is causing these prob-
lems. (See Troubleshoot Startup and Login Items, later, for more
info.)

TIP To disable all your login items temporarily without removing them,
press the Shift key after you enter your user name and password in
the login window, (or if you have automatic login set, after the Mac
displays the Starting Mac OS X screen) and keep holding it until login
is complete.

Manage Startup Items
Startup items are system-level items, found in /Library/
StartupItems and /System/Library/StartupItems, that
launch or load when you turn on your Mac. These include drivers,
kernel extensions, menu extras, preference panes, and more. Every
Mac has lots of startup items that launch each time it boots. And
when you install third-party software, especially drivers for input
devices, additional startup items may be added to your system.

GEEK FOOD To get the nitty-gritty on startup items, see this Apple developer
document on the boot process and startup items:
http://developer.apple.com/documentation/MacOSX/Conceptual/
BPSystemStartup/Concepts/BootProcess.html.

http://developer.apple.com/documentation/MacOSX/Conceptual/BPSystemStartup/Concepts/BootProcess.html
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If you’ve used the Mac since Mac OS 9 or earlier, you may remember
that you could start up your Mac while pressing Shift to deactivate
extensions. This troubleshooting operation helped determine whether
a problem was caused by an extension. Under Mac OS X, startup
items are the closest things to extensions, and you can use the same
technique to boot your Mac without loading these startup items.

To boot the Mac in Safe Mode, in which Tiger loads only essential
system startup items and runs a disk check that’s equivalent to check-
ing the disk with Disk Utility, as you hear the startup chime, press the
Shift key and release it just after the Mac displays the gray Apple and
the spinning gear. This disables most Startup Items, yet still runs
some of the basic items that are required for the system, so you can
work with your keyboard and mouse, and use your video card.

You may not want to work in Safe Mode for any length of time, but
you should be able to determine if a non-essential startup item is
causing problems much as the extensions of yesteryear did.
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TROUBLESHOOT STARTUP AND LOGIN ITEMS

I suggested creating an account for troubleshooting earlier, in Set up
a troubleshooting account; now, here’s a brief explanation of how to
use this account, and how to troubleshoot startup items and login
items. If you notice a reproducible problem with your Mac, that is, a
problem you can make happen again by doing certain things in a cer-
tain order, or if you experience a problem that happens quite often
(even if you’re not sure why), you can test if startup items or login
items are causing it. Here are the steps:

1. Create a new administrator account (if you don’t already have one)
for troubleshooting. This troubleshooting account should be a vir-
gin account, with no additions, drivers, or extra software. (See Set
Up an Account for information on setting up the new account.)

2. Log in to your troubleshooting account and see if your problem
disappears, either by trying the specific actions that cause it to
happen or by working for a while in a way that typically brings
on the problem.

• If your problem goes away: There’s a good chance that it
relates to your normal account. Specifically, one or more login
items may be the culprit, but your problem could also be caused
by certain user preferences. Continue with Step 3, next.

• If your problem doesn’t go away: Then it has nothing to do
with a particular account; skip ahead to Step 5.

NOTE Problems can occur for many reasons besides just bad login items or
preference files, and this ebook is not designed to diagnose them.
For help, see the Resources section near the end of this ebook.
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3. Now that you know that something about your normal account is
causing the problem, check if a login item is the culprit by logging
back in to your normal account with login items disabled. To do so,
press the Shift key after authenticating in the login window, (or if
you have automatic login set, after the Starting Mac OS X screen
appears), and keep holding Shift until login is complete.

• If the problem goes away: You’ve pinpointed a login item as
the cause. Continue with Step 4.

• If the problem doesn’t go away: Skip ahead to the next
section, Troubleshoot Preference Files.

4. While logged into the problem account, in Accounts system pref-
erences, in the Login Items pane, note which login items are load-
ing (Figure 9). If you like trying out shareware and freeware, or
if you installed drivers for hardware you no longer use, their login
items might be causes of the problem; however, you may have to
test systematically to find the culprit.

FIGURE 9 Here is the Login Items
list for my standard ac-
count. I added the first
five items. The others
were added by installers
or programs; for in-
stance, Transport Mon-
itor is for my Palm PDA
and System Events was
added when I turned on
Folder Actions.

If removing a login item solves the problem, congratulations; you
can stop here! If you want to replace it, try re-installing its assoc-
iated software or checking if a later version is available.
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EXAMPLE After installing Tiger, I had to reinstall certain drivers, including one
for my Canon LIDE 30 scanner. The installer added a pair of back-
ground button managers that control buttons on the scanner to my
Login Items list: one for my scanner and one for a different model. I
don’t use these buttons, so I deleted both items, but if I did want to
use my scanner’s buttons, I would have deleted only the login item
that didn’t correspond to my scanner model.

5. If your problem occurs when you log in both with a regular account
and with your troubleshooting account, then you can’t blame the
problem on something specific to the regular account. If that’s the
case, the next thing to check for is if any startup items are at fault:
boot your Mac in Safe Mode, as described earlier in Manage
Startup Items.

• If your problem goes away: You can be sure that a startup
item is guilty. Move on to Step 6 to see how to deactivate
startup items.

• If your problem does not go away: You have run out of
luck with these steps. Your problem relates neither to a specific
account nor to your startup items. It’s outside the scope of this
ebook, and you may wish to consult a Web site or book such as
those listed in Resources.

6. To find the problem startup item, you must deactivate a group of
items (or just one). Then restart your Mac and see if the problem
has gone away.

When deactivating startup items, it’s dangerous to work with the
two StartupItems folders, because they contain many essential
items that you can’t work without, and you absolutely should not
move or delete anything you find in them. You can, however, use
a tool such as Diablotin (see the sidebar, next) to temporarily
deactivate certain startup items for testing purposes. Remember
that you must restart after deactivating different system startup
items to see if your problem has gone away or not.
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SIDEBAR To manage and deactivate system startup items (and other items as
well), the best tool is Diablotin (that’s French for little devil, or imp),
a freeware preference pane by Stéphane Sudre (Figure 10).
http://s.sudre.free.fr/Software/Diablotin.html

FIGURE

10
Diablotin
is a handy
tool for
turning on
and off
many
types of
add-ons.

Diablotin is a sort of Extensions Manager for Mac OS X. It displays
a list of categories, and you can click an expansion triangle to show
a category’s contents. If you select the Show System Library Items
checkbox, the StartupItems category at the bottom of the list also
displays essential kernel extensions and services. Be careful—if you
deactivate any of these you may not be able to boot your Mac.

You can deactivate any item in the categories that Diablotin displays
by deselecting the item’s checkbox. Some items are protected and re-
quire that you authenticate by clicking the lock icon and entering an
administrator password. (Even if you are an administrator, Diablotin
protects you against making stupid mistakes by requiring you to click
the lock to make changes.)

In the StartupItems category you’ll find startup items that act at a sys-
tem level, and there may be some which don’t belong there, because
they correspond to software you’ve long since removed from your
Mac.

Bear in mind that disabling any startup items may affect your system
or applications in unexpected ways, but when troubleshooting, it’s
worth trying to see if it solves your problem.

http://s.sudre.free.fr/Software/Diablotin.html
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TROUBLESHOOT PREFERENCE FILES

Each account has many preference files, which are stored in
~/Library/Preferences. Many, though by no means all, of these
files have names ending with .plist.

Sometimes these files can become corrupted—this can occur if an
application crashes, if you have a kernel panic, or if a program writes
the wrong data in a file. Corrupted preference files can cause crashes
and freezes, and, if these files affect the system, as opposed to indi-
vidual applications, they can lead to widespread problems.

If you think you have a problem with a user account’s preference files,
try Steps 1–3 in “Troubleshoot Startup and Login Items,” previously,
to find out for sure. To troubleshoot a problem with user preferences,
follow these steps:

1. Remove preference files for any applications that are causing prob-
lems. For example, if you’re having problems in the Finder, move
the com.apple.finder.plist file to the Desktop, then log out
and log in again. If you’re having problems with a specific applica-
tion, quit the application, move its preference file, and then launch
it again.

If you remove a preference file from the Preferences folder, the
associated application will recreate it on the next launch. The new,
default preference file won’t contain any custom settings you’ve
applied. (The old preference file, the one on the Desktop, still holds
your settings.)

• If your problem goes away: You’ve found the culprit (or
narrowed the culprit down to one of the preference files you re-
moved). Go ahead and delete the offending file and get on with
your life. However, if you are missing custom settings, you
should reset them. If resetting them would be time consuming,
you may be able to restore an old copy of your preference file
from a backup.

• If your problem doesn’t go away: Put your old preference
file back (so you don’t have to recreate your custom settings),
and move to the next step.
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WARNING! Removing a preference file may cause an application to think it hasn’t
been registered properly. That’s why you should keep the old prefer-
ence file until you’re sure it’s the problem, and even then, don’t throw
it out until you verify that you have the registration code for the
application in question.

2. If moving a few preference files to the Desktop fails to address
your problem, try moving your entire Preferences folder to the
Desktop and restarting.

• If the problem goes away: You know for sure that a prefer-
ence file is guilty, but now you need to find which one. Continue
with Step 3.

• If the problem does not go away: The user preferences are
not causing the problem. If you already followed the steps in
Troubleshoot Startup and Login Items, then, unfortunately,
your problem is outside the scope of this ebook. One of the
items mentioned in Resources may prove useful.

3. Return the Preferences folder to your Library folder, view the
Library folder in List view, and sort the files by Date Modified
(Figure 11), using the expansion triangles to see the folder con-
tents. You should work by trial and error: start with preference
files that changed recently by moving those files to the Desktop,
and then log out and log in. If the problem doesn’t go away, replace
those files and try some more. Continue this process until you find
the corrupt preference file.
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FIGURE 11

Go to your Preferences folder (~/Library/Preferences), and click
the Date Modified column to display preference files according to
the last date they have been changed. (If the triangle in the column
header points up, the sort order is reversed; it displays the oldest
files first. Click the header again to change the sort order to show
the most recent files at the top.)
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SHARE FILES AMONG USERS

If several users have accounts on the same Macintosh, it’s likely that
they will want to share files among their accounts. One user will want
another to check his report, or give pictures he received by email to
other users, or all users may want to access common data such as
digital music files or photos.

NOTE Although I talk here about sharing files among users on the same
Mac, I’m not talking about file sharing, which involves sharing and
accessing files on two or more computers over a network. If none of
these options seem sophisticated enough for your requirements, you
may wish to look into file sharing and the various options it includes,
such as dedicated file-sharing servers, FTP servers, and more. That’s
the subject of another Take Control ebook, Glenn Fleishman’s Take
Control of Sharing Files in Tiger.
http://www.takecontrolbooks.com/tiger-sharing.html

You can share a file on a Macintosh using one of four common loca-
tions, each of which has pros and cons. I summarize these methods in
Table 3, next, and discuss each option more thoroughly later in this
section.

http://www.takecontrolbooks.com/tiger-sharing.html
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Table 3: Four Ways to Share Files among Users

Sharing Method Advantages Disadvantages

Shared volume • Allows full access to all users.

• You can set the volume to
ignore permissions.

• Generally offers more disk
space than other methods.

• You need a dedicated volume
or hard disk.

• Shared volumes must be
accessible; internal shared
volumes must be mounted,
external shared volumes must
be on, and network volumes
must be available.

• Files are accessible to all users.

/Users/Shared
folder

• You don’t need a dedicated
volume or hard disk.

• This folder is always acces-
sible; you don’t need to
worry about turning on a
drive or network server.

• You need to be aware of
permissions issues.

• Files are accessible to all users.

Public folders and
Drop Boxes

• Files in your Public folder
are accessible to all users.

• You can transfer files to a
single user, ensuring that no
other user can access them.

• Your Drop Box is secure;
users can only copy files to
other users’ Drop Box folders.

• Files in your Public folder are
accessible to all users.

• Using the Drop Box folder
requires that you transfer files
to each of several users
individually.

iDisk • Files on your iDisk’s Public
folder are accessible to all
users, though you can limit
access by setting a password
to protect this folder.

• You can access files in your
iDisk’s Public folder from an-
other Mac, from a Windows
computer, or even from a
Web page.

• Copying to and from an iDisk is
slow.

• Additional iDisk space beyond
the maximum 235 MB avail-
able from a standard 250 MB
.Mac account is expensive.

• Files in an iDisk’s Public folder
are accessible to all users, and
even to the public, though you
can limit access by password-
protecting this folder.
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Share Files via a Shared Volume
If you have more than one partition on your internal hard disk, or if
you have more than one hard disk (internal or external) you can use
one of these volumes as a shared volume. This is often the best way to
share files among users on a single Mac, for two reasons:

• Ease of use: Because you can turn off permissions for the entire
volume, users can read (view and open) and write (copy and save)
files on this volume without running into confusions caused by
permissions settings. Of course, you should turn off permissions
only if the files on the volume should be shared with everyone who
could conceivably access them.

• Large amount of space: A shared volume is likely to have a
large amount of disk space, giving you plenty of room to store
commonly shared files, particularly large ones such as digital
music files, photos, or movies.

To configure a shared volume so that users can have read-and-write
access, do the following:

1. Working on the Desktop or in a Finder window, select the volume
you want to share and choose File > Get Info (Command-I) to open
the Info window for the volume.

2. If the Ownership & Permissions section is closed, click its expan-
sion triangle to display the volume’s permissions.

3. Check Ignore Ownership on This Volume.

Mac OS X now ignores permissions and ownership for all files placed
on this volume. All users, except those with simplified accounts, can
work with files on this volume.

Share Files via the Shared folder
Every installation of Mac OS X has a /Users folder that contains
home folders for all the accounts created on the Mac. The /Users
folder also contains a special Shared folder that is designed so anyone
can place files in the folder or copy files from it. All users have access
to this folder, even users with simplified accounts, who see it as one of
the three folders in the Dock.
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In many cases, using the Shared folder is simple: you copy files you
want other users to access into this folder, and they can copy them
into their personal folders at any time. But, in practice, there are a few
sticky points with using the Shared folder as a file exchange location.

Sharing files via the Shared folder is not as flexible as using a shared
volume. Files in the Shared folder retain permissions according to
the user who placed them there, and, although users can copy files
from the Shared folder to their home folders, changing the files’ per-
missions as they do so, users may not be able to open and edit files
directly from this folder.

NOTE Mac OS X uses file permissions to tell the system which user owns a
file, and what access other users can have. Some files or folders offer
read-only access, so other users can read or copy them to other fol-
ders where they have write access, but not make changes to them in a
read-only folder; others offer read-and-write access, so others can do
whatever they want. Still other files and folders may give no access to
other users.

When you place a file in the Shared folder, this file retains your ow-
nership: you are listed as the file’s owner, you have read-and-write
access, and other users have read-only access. For another user to be
able to modify your file he must copy it into his home folder or one of
its subfolders; copying the file changes the permissions to give him
ownership and full access, and he can use the file in any way he
wants. This permissions change on copying applies to files, folders,
and applications.

However, the original file remains in the Shared folder with its orig-
inal permissions. So, say Henry David Thoreau wants his friend
Ralph Waldo Emerson to review something he wrote. If Henry places
a copy of Walden in the Shared folder, Ralph may naturally try to
launch the file, by double-clicking it, instead of copying it to his home
folder. While he can read and therefore open the file, in most cases
he’ll find that he cannot write to it, and therefore cannot save his
changes to the original file.
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Ralph can copy this file into his home folder, read it, make changes
and comments to it, and save it. But when Ralph tries to copy the file
back to the Shared folder, he comes up against a hurdle—Ralph
doesn’t have permission to change the original file by replacing it with
the version he has reviewed (see Figure 12). So he must give the file
a new name before he can place it in the Shared folder. Alternatively,
Ralph can use the File > Save As option to save the file in the Shared
folder under a new name.

FIGURE 12

After working on a file copied from the Shared folder, another user
cannot return the file to this folder under the same name because
doing so would replace the original, which still belongs to the user
who placed it there.

In summary, any files you want to replace in the Shared folder, after
changing them in any way, must have different names than their
originals. (Realistically, this issue isn’t a major problem in many
collaborative working environments, because it’s common practice
for the file name to contain a version number as well, and for each
user to increment that version number after editing the file.)

By this same logic, only the user who placed files in the Shared folder
can delete them, though an administrator can also do so by authen-
ticating.

In spite of this minor annoyance, the Shared folder is the best way for
users to share occasional files if no shared volume is available. Any-
one can access this folder, and anyone can copy files to and from it.
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SIDEBAR CHANGE PERMISSIONS ON SHARED FILES

For a file like an AppleWorks database that you want to share perma-
nently without requiring each user to copy it in and out of the Shared
folder, there’s another alternative: setting the permissions on the file
to give any user read-and-write permissions. Follow these steps:

1. Copy the desired file to the Shared folder.

2. Select it, and choose File > Get Info (Command-I) to display the
Info window for the file.

3. Open the Ownership & Permissions expansion triangle, if neces-
sary, and open the Details expansion triangle inside.

4. From the Others pop-up menu, choose Read & Write; then close
the Info window.

Now any user on your Mac can read and write to the file. If either
user overwrites the file by copying a new version into the Shared
folder, you’ll have to run through these steps again.

Share Files via Public Folders and Drop Boxes
Each user’s home folder contains a Public folder, which holds files the
user wishes to share with others (it functions like a publicly viewable
out-box). Further, the Public folder contains a Drop Box folder (like a
private in-box), which can receive files from others. Sharing files via
Drop Box folders is best if you want to share files with individual
users without providing access to all the users on your Mac or on your
network.

Public folders
To use your own public folder, place files that you wish to share into
it. Once you place a file in your Public folder, other users can see and
copy that file. (As with the Shared folder, Mac OS X changes the per-
missions of the file when it is copied out of your Public folder, making
it the property of the person copying it.) Figure 13 shows what other
users see when they visit your home folder.
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FIGURE 13

Red do-not-enter symbols in a user’s home folder show which fold-
ers other users cannot access. The six folders with the do-not-enter
symbol are private; the Public folder and the Sites folder (used for
Personal Web Sharing) are accessible to other users.

WARNING! Be aware of two things. First, all users can access your Public folder,
so files you place there can be copied by any user, whether he physi-
cally uses your Mac or connects to it over a network. Second, all users
can access the contents of your home folder, so don’t save files at the
top level of this folder, if you are concerned about this. You can see
in Figure 13 that the do-not-enter symbols are on only six of your
home folder’s sub-folders. If you create additional folders directly in
your home folder, other users can access them and copy files from
them, just like your Public folder.

Feel free to organize materials stored in the Public folder by creating
folders inside your Public folder; for example, if you want users to
know which files you have left for them, you could create folders with
their names, such as For Ralph, For Louisa May, and For Nathaniel.
This won’t prevent other users from viewing their contents or copying
these files, but it will help users find the files intended for them. If
you don’t care who sees these files, this is a good solution.
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Drop Box folder
The Public folder works well for providing other people with files you
want to share, but how do they return files? They use the Drop Box
folder, which is located inside the Public folder (see Figure 14).

FIGURE 14 The Drop Box is a write-only folder; you cannot
open another user’s Drop Box folder. You can only
copy files into it by dragging them onto its icon.

You can copy any files you want into another user’s Drop Box, and
these files will inherit that user’s permissions. But you can’t retrieve
any files from the Drop Box if you make a mistake, nor can you copy
over any files you’ve already placed there. To replace a file you must
change its name first, and make sure the owner of the Drop Box
expects to find the second file with a different name.

Share Files via an iDisk
The final suggestion I have for sharing files with other users on the
same Mac is the slowest and suffers from size limitations: if you have
a .Mac account, you can use your iDisk as a repository for shared files.
To set up your Mac for sharing files via your iDisk, set the same user
name and password in the .Mac preference pane for each user on
your Mac. That way each user sees the same iDisk in the Finder.
(Mount your iDisk in the Finder by choosing Go > iDisk > My iDisk
or pressing Command-Shift-I).

Then copy the files you want to share to any of the iDisk’s folders; the
files magically inherit the correct permissions once a user mounts the
iDisk, no matter which user owned the files when copying them to the
iDisk. The advantage to sharing files via your iDisk is that any user
with the correct .Mac user name and password can delete or replace
files on the iDisk; nobody has to rename files, as is generally true for
using the Shared folder or the Drop Box folder.
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In addition, by placing files in your iDisk’s Public folder, you allow
anyone to access them from Windows computers, using Apple’s iDisk
Utility, or from the Web, if you set up a file-sharing home page for
your .Mac account. Bear in mind that “anyone” really does include
anyone on the Internet (unless you protect the Public folder with a
password; see the tip next), which may not be what you want.

TIP To protect your iDisk’s Public folder with a password, so strangers
cannot access your files, open the .Mac preference pane in System
Preferences. Click the iDisk tab, check Password Protect Your Public
Folder, and enter a password. You must give this password to anyone
who wants to access your iDisk’s Public folder. This password also
protects any file-sharing Web page that you set up with .Mac.

You’re not limited to using your iDisk’s Public folder for sharing files
among users of your Mac; you can put files in any of your iDisk’s
other sub-folders (though it’s best to stick with Documents, Movies,
Music, and Pictures). The good part about using one of the other sub-
folders is that you don’t need to worry about other people on the
Internet being able to access your files.

The primary disadvantage to using an iDisk to share files locally is
that it is slow; it takes a long time to copy files to and from the iDisk,
even if you have a relatively fast Internet connection. Also, by default,
your iDisk provides only 250 MB of space (shared between your iDisk
and your .Mac email account, with a 235 MB maximum allowed for
the iDisk), which isn’t much these days. You can buy more, but it’s
an expensive way to share files among users on the same Mac.
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RESOURCES

Consult these books when things go wrong with your Mac:

• Mastering Mac OS X, 4th Edition (Sybex), by Todd Stauffer and
Kirk McElhearn

• The Mac OS X Command Line: Unix Under the Hood (Sybex), by
Kirk McElhearn

• Mac OS X Power Tools, Second Edition (Sybex), by Dan Frakes

• Mac OS X Help Line, Tiger Edition (Peachpit), by Ted Landau

And some of the best troubleshooting Web sites are:

• MacFixIt: http://www.macfixit.com/

• MacInTouch: http://www.macintouch.com/

• Mac OS X Hints: http://www.macosxhints.com/

• Apple’s troubleshooting site: http://www.apple.com/support/

• Apple’s troubleshooting discussion forums:
http://discussions.info.apple.com/

http://www.macfixit.com/
http://www.macintouch.com/
http://www.macosxhints.com/
http://www.apple.com/support/
http://discussions.info.apple.com/
http://www.mcelhearn.com/tiger.html
http://www.mcelhearn.com/unix.html
http://www.amazon.com/exec/obidos/ASIN/0782143199/takecontroleb-20/ref=nosim/
http://www.amazon.com/exec/obidos/ASIN/0321334299/takecontroleb-20/ref=nosim/
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APPENDIX A: SHARE DIGITAL MEDIA FILES

Lots of people want to share songs and photos that are stored on their
computers, and the most common tools that Mac OS X users use to
access shared songs and photos are iTunes and iPhoto.

By default, when a user first launches iTunes or iPhoto, the program
creates its own storage folder inside that user’s home folder. iTunes
creates ~/Music/iTunes and iPhoto creates ~/Pictures/iPhoto
Library. Despite this similarity, you use different methods to share
music and photos among users on a Mac.

Share Your iTunes Library
It’s easy to share music in iTunes because iTunes is happy to load its
music files from any location. Follow these steps:

1. If you have already ripped some of your CDs to MP3 or AAC files,
copy your ~/Music/iTunes/iTunes Music folder to the
Shared folder. Otherwise create a new folder in Shared called
iTunes Music. You can also put the iTunes Music folder on
a shared volume; see Share Files via a Shared Volume, earlier, and
adjust the instructions in Step 2b accordingly.

2. For each user in turn:

a. Launch iTunes, choose Preferences (Command-,) from the
iTunes menu, and click the Advanced button.

b. Click the Change button next to the iTunes Music Folder
Location, and then navigate to and select the iTunes Music
folder in the Shared folder. Click OK to save your changes.

c. In the Finder, select all the songs in the shared iTunes Music
folder and drag them into the iTunes window to import them.

This approach has the advantage of letting multiple users share the
same music while still letting everyone create and maintain individual
playlists, since the playlist information stays with each user.
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On the downside, every time you rip a new CD, each user must import
the songs from it manually by dragging them into iTunes. The silver
lining in that cloud is that each user can pick and choose which of the
shared albums to import.

TIP You can also put the iTunes Music folder on a shared network volume
and access it via file sharing, but that’s a topic of another Take
Control ebook, notably, Glenn Fleishman’s Take Control of Sharing
Files in Tiger.
http://www.takecontrolbooks.com/tiger-sharing.html

Share Your iPhoto Library
Sharing your iPhoto Library is more complex than sharing your
iTunes Music folder because iPhoto is more particular about where
its files live, and because all users need read-and-write access for
importing and editing purposes. The trick is that you must put the
iPhoto Library folder on a shared volume (or a network volume);
the /Users/Shared folder won’t work well. (To set up the shared
volume, see Share Files via a Shared Volume, previously, and follow
the steps to turn off permissions to the volume so all users can access
the files.) Here are the steps, which work with iPhoto 2, 4, and 5:

1. Back up your photos before starting these steps.

2. Make sure iPhoto is not running.

3. Open a Finder window showing the location on the shared volume
where you want to store your iPhoto Library folder.

4. Open another Finder window showing your Pictures folder.

5. Press Command while dragging the iPhoto Library folder to move
it from the Pictures folder to the shared volume. (By pressing
Command after you start dragging, you tell the Finder to move the
folder rather than copy it.)

http://www.takecontrolbooks.com/tiger-sharing.html
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6. For each user in turn, press Command-Option and drag the iPhoto
Library folder to ~/Pictures. (By pressing Command-Option
while dragging the folder to a user’s Pictures folder, you tell the
Finder to make an alias in the destination rather than copying the
folder.) By default, iPhoto always looks for a folder called “iPhoto
Library” in the Pictures folder, and it accepts an alias happily.

7. Verify that each user can import a photo and edit existing photos,
and that every other user can see the results of those changes.
After that, all users can use iPhoto with the shared iPhoto Library
just as they would normally.

NOTE Why can’t you use the /Users/Shared folder when sharing iPhoto
photos among users on the same Mac? The Shared folder doesn’t
work well, because the permissions that iPhoto sets when one user
imports new photos prevent other users from editing those photos.
Another way around the problem is to use iPhoto Library Manager
(http://homepage.mac.com/bwebster/iphotolibrarymanager.html)
to create and work with several libraries from within a single user
account.

http://homepage.mac.com/bwebster/iphotolibrarymanager.html
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And now, a shameless plug for my latest books:
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iPod & iTunes Garage is the ultimate iPod
book. Learn how to do everything with your
iPod, how to manage your music with iTunes,
and how to use additional software and
accessories to make sure the music never
stops.

• And for those who like to fiddle with things,
tweak their Macs, and access the hidden
power behind Mac OS X, my recent book The
Mac OS X Command Line: Unix Under the
Hood will teach you how to use the command
line to get the most out of your Mac.

Find out more about both of these books, and
others, at http://www.mcelhearn.com/.
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